Data Collection Software
U-50PC
(P-No P2000484001A ver.1.0.1.5)

Instruction Manual

CODE: GZ0000145277A
Preface

This manual describes the operation of the Data Collection Software, U-50PC. Be sure to read this manual before using the product to ensure proper and safe operation of the instrument. Also safely store the manual so it is readily available whenever necessary. Product specifications and appearance, as well as the contents of this manual are subject to change without notice.

Licensing

HORIBA, Ltd. agrees that the customers use the software and this instruction manual provided that the following information is well observed by the customers.

■ Copyright

HORIBA, Ltd. owns this software copyright.

■ Range of licensing

Customer can use the software in a single computer that the customer has and uses it on his own. The licensing that the customer obtains is nonexclusive rights and shall not be assigned.

■ Duplication

Customer can only duplicate the software for his/her own backup purpose. The duplicated product shall never be used by a third person. Reverse engineering or any other equivalent action shall be prohibited.

■ Warranty and indemnification

• HORIBA, Ltd. shall not be liable for any possible damages resulting from failure of this software, any erasure of data, or any other uses of this software.
• This software is designed for a connection between one Meter and one PC. Connecting multiple Meter or using hub network may not always guarantee the performance of this software.
• HORIBA, Ltd. can't compensate even if there are mistakes in this instruction manual.
• Specification of this software may be modified without any advanced notifications.

Trademarks

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Generally, other company names and bland names are either registered trademarks or trademarks of the respective companies.
Index

1 About the software ...........................................................1
  1.1 What this software can do .....................................................1
  1.2 Symbols/Expressions ............................................................1
  1.3 Precautions .........................................................................1

2 Functions and operating environment ...........................2
  2.1 Functions .............................................................................2
  2.2 System configuration .............................................................2
  2.3 System components ..............................................................2
  2.4 Computer specifications ......................................................3

3 Setup ..................................................................................4
  3.1 Installation of the software ....................................................4
  3.2 Connecting the meter and computer, and installing the driver ....7
  3.3 Setting of port .......................................................................9
  3.4 Uninstall the Software ........................................................12

4 Start-up and exit ..............................................................14
  4.1 Start up ...............................................................................14
  4.2 Exit .....................................................................................15
  4.3 Main window ....................................................................16
     4.3.1 Menu bar ....................................................................16
     4.3.2 Data information ..........................................................18
     4.3.3 Measured data ..............................................................18
     4.3.4 Meter error .................................................................19
     4.3.5 Communication confirmation ......................................19
     4.3.6 Measurement status ....................................................20
     4.3.7 Data No ......................................................................20
     4.3.8 Importing measured data/download data .....................20
     4.3.9 Graph .........................................................................21
     4.3.10 Menu bar tree and shortcut button .........................22

5 Importing measured data ...............................................23
  5.1 Setting of cycle (time interval) of data import ....................23
  5.2 Importing measured data ....................................................24
  5.3 Stop importing ...................................................................24

6 Download .........................................................................25

7 Saving and opening files ...............................................26
  7.1 Saving file .........................................................................26
  7.2 Open file ............................................................................26
  7.3 Format of csv file ..............................................................27

8 Graph ...............................................................................28
  8.1 Main window graph ............................................................28
     8.1.1 Cursor ........................................................................28
     8.1.2 Setting of the number of graphs displayed ..................28
     8.1.3 Graph settings .............................................................29
  8.2 X-Y graph .........................................................................31
     8.2.1 Displaying the X-Y graph ............................................32
     8.2.2 X-Y graph explanation ................................................32
     8.2.3 Graph settings .............................................................33
  8.3 Depth graph (U-52G, U-53, U-53G) ......................................34
     8.3.1 Displaying the depth graph ...........................................34
     8.3.2 Depth graph explanation ..............................................35
8.3.3 Add/delete data ........................................................................................................37

9 Troubleshooting ............................................................................................................38
9.1 Checklist ....................................................................................................................38
9.2 To contact your local agency ..........................................................................................38
1  About the software

1.1  What this software can do
This software is dedicated for the U-50 Series Multi Water Quality Checker. It can import measured data into the computer and save it as a csv-formatted file. It can also import meter memory data.

1.2  Symbols/Expressions
- The symbols used in this manual regarding Windows operations and screens are listed as follows.
  - [ ]: buttons and menus
  - < >: Window and dialog box titles
- The U-50 Series Multi Water Quality Checker is expressed as "the meter".
- Explanations of Windows operations are illustrated using Windows XP.

1.3  Precautions
Before using the software, please read the following precautions.
- Be aware that this software is not guaranteed to work on all computers.
- Only the administrator of the computer can install this software.
- This software may not work properly while other applications are running.
- It might be different from the example of the screen of this manual according to the version of the U-50 series.
2 Functions and operating environment

2.1 Functions
The software has two main functions, "importing measured data" and "downloading data".

- Importing measured data
  Real time data measured by the meter is imported into the computer and displayed as a graph. The measured data can also be saved as csv format.

- Downloading data
  Data saved in memory on the meter can be imported into the computer. You can also create a graph and save the data as csv format.

2.2 System configuration
The system configuration diagram is shown below.

<table>
<thead>
<tr>
<th>System components</th>
<th>Meter</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications</td>
<td>U-51, U-52, U-52G, U-53, U-53G</td>
<td>See &quot;2.4 Computer specifications&quot;</td>
</tr>
<tr>
<td>cable</td>
<td>Option: Part No. 3200174823. Commercial part: A USB cable with a USB A plug and a USB B plug for both ends. (Mini plugs and micro plugs cannot be used)</td>
<td></td>
</tr>
</tbody>
</table>
2.4 **Computer specifications**

Table 1 shows necessary and recommended computer specifications.

<table>
<thead>
<tr>
<th>Item</th>
<th>Necessary specification</th>
<th>Recommended specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>800 MHz or higher</td>
<td>1 GHz or higher</td>
</tr>
<tr>
<td>Memory</td>
<td>512 MB or higher</td>
<td>1 GB or higher</td>
</tr>
<tr>
<td>Free hard drive</td>
<td>15 GB or higher</td>
<td>15 GB or higher</td>
</tr>
<tr>
<td>OS</td>
<td>Windows XP or Windows Vista</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Super VGA (800 x 600) or higher</td>
<td></td>
</tr>
<tr>
<td>Connector</td>
<td>USB A connector</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

This software may not operate correctly if memory or hard drive space is not enough.
3 Setup

Installation of the software and installation of the driver are necessary to use the software.

3.1 Installation of the software

Note
To install the software, log in as a user with Windows administrator rights.

- Installation
  
  Preparation of executable file
  
  Setup with CD
  1. Insert the setup CD into the computer's CD-ROM drive.
  2. Double click "U50Setup.exe" in the root directory of the setup CD to start the installation.

  Setup with downloaded file
  1. Decompress the downloaded folder "U50Setup.lzh" and save the file "U50Setup.exe" to the folder.
  2. Double click "U50Setup.exe" to start the installation.

Start the installation

1. Select your language in <Choose Setup Language>, and click [OK].

![Choose Setup Language](image-url)
2. <InstallShield Wizard> is displayed, then click [Next >].

Note
Click [< Back] when you wish to return to an operation at any time during the installation.

3. Enter [User Name:] and [Company Name:], then click [Next >].

4. Select the [Destination Folder] to be saved this software, and click [Next >].
5. Enter [Program Folders:] and click [Next >]. "U-50" is recommended to name the folder.

6. Confirm the installation settings and click [Next >].

7. Click [Finish] to complete software installation.
3.2 Connecting the meter and computer, and installing the driver

In order to connect the meter to the computer, the driver must be installed on the computer.

- **Driver installation setup**
  1. Decompress the downloaded file "CDM 2.00.00.zip" and save it in the folder.

- **Cable connection**
  1. Ensure that the meter’s power is turned off.
  2. Connect the communication cable.

- **Driver installation**
  1. When the communications cable is connected to the computer, new hardware is detected on the computer and the following screen will be displayed. Select [Install from a list or specific location (Advanced)] and click [Next >].

![Found New Hardware Wizard](image)
2. Select [Search for the best driver in these locations.] and check [Include this location in the search:]. By pressing [Browse], specify the folder where "CDM 2.00.00.zip" were decompressed and click [Next >].

![Found New Hardware Wizard]

3. Click [Finish] to complete set up.

![Found New Hardware Wizard]

4. Double click the downloaded file "CDM_Setup.exe", and the following screen is displayed. Click [OK] to complete the installation.

![FTDI Driver Installation]
3.3 Setting of port

The port must be set before importing and downloading data.

- **Procedure**
  1. Confirm the COM port communications cable is recognized.
  2. Select the port in the software.

- **Confirm the computer’s port**
  1. Select [Printers and Other Hardware] on <Control Panel>.

  ![Control Panel](image1)

  2. Select [System] under the [See Also] menu on the [Printers and Other Hardware] window.

![Printers and Other Hardware](image2)

4. Select [Ports (COM & LPT)] on the <Device Manager>. Check the COM number of [USB Serial Port (COMX)]. Example below shows COM1 as USB communications port.
Software settings


2. Select the port number. COM1 is selected in this example.

The port number can be selected from COM1 to COM19.
3.4 **Uninstall the Software**

1. Display the <Control Panel> and select [Add or Remove Programs].

2. Select [U-50 Data Collection Software] from the [Change or Remove Programs] list in <Add or Remove Programs>, then click [Change/Remove].
3. Select [Remove] and click [Next >].

4. Click [OK] in <Confirm Uninstall>.

If <Locked File Detected> is displayed, check [Don’t display this message] and click [Ignore].

5. Click [Finish] to complete software uninstallation.
4 Start-up and exit

4.1 Start up


![U-50 Data Collection Software](image)
4.2 Exit

Select [Exit] from [File] menu or click the [Close] button in the upper-right of the window. During importing measured data, the software cannot be closed. Stop importing to close the software. (See "5 Importing measured data.")
4.3 Main window
On the main window, you can select functions of "Import measured data" or "Download data", and settings of port or graph.

4.3.1 Menu bar

- **[File] menu**
  You can select [Open] to open a file, [Save] to save data, or [Exit] to exit the software.
- **[Data] menu**
  You can select [Import measured data], [Stop importing], [Download data], [Select data], or [Clear].

- **[Graph] menu**
  You can select [Disp numbers] to select the number of graphs displayed, [Settings] for graph settings, [Depth graph] to create a depth graph, or [X-Y graph] to create an X-Y graph.

- **[Settings] menu**
  You can select [Port] to port settings or [Import cycle] to import cycle setting.

- **[Help] menu**
  You can select [About] to display version information.
### 4.3.2 Data information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>data1.csv</td>
</tr>
<tr>
<td>SITE</td>
<td>H0RIBA</td>
</tr>
<tr>
<td>DateTime</td>
<td>2006/08/07 19:37:56</td>
</tr>
<tr>
<td>GPS</td>
<td>34 58 53 N / 135 43 26 E</td>
</tr>
</tbody>
</table>

- **<File>**
  File name is displayed when measured data is saved or opened.

- **<SITE>**
  Set SITE is displayed.

- **<DateTime>**
  Date and time are displayed when data was acquired.

- **<GPS>**
  GPS data is displayed.
  * GPS data is added to the data when acquired with the U-52G or U-53G.

### 4.3.3 Measured data

#### Measured data

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp</td>
<td>24.83 °C</td>
</tr>
<tr>
<td>pH</td>
<td>6.99 pH</td>
</tr>
<tr>
<td>pHmV</td>
<td>0 mV</td>
</tr>
<tr>
<td>ORP</td>
<td>992 mV</td>
</tr>
<tr>
<td>Cond</td>
<td>4.49 mS/cm</td>
</tr>
<tr>
<td>Turbidity</td>
<td>12.0 NTU</td>
</tr>
<tr>
<td>DO</td>
<td>4.54 mg/L</td>
</tr>
<tr>
<td>DC%</td>
<td>56.3 %</td>
</tr>
<tr>
<td>TDS</td>
<td>2.87 g/L</td>
</tr>
<tr>
<td>Salinity</td>
<td>1.7 ppt</td>
</tr>
<tr>
<td>SG</td>
<td>0.0 Sigma 1</td>
</tr>
<tr>
<td>Depth</td>
<td>7.55 m</td>
</tr>
</tbody>
</table>
4.3.4 **Meter error**
This field turns in red in case of meter.

![Warning](Warning) Meter error occurs -> ![Warning](Warning)

- Identified meter errors
  - Probe ADC error
  - Probe EEPROM error/Factory
  - Probe EEPROM error/User
  - Display unit RTC error
  - Display unit FROM error
  - Turbidity lamp error
  - Turbidity wiper motor error
  - Probe Capacitor error
  - Probe EEPROM error
  - Display unit data store error
  - Probe PC board defect

**Reference**
See U-50 series instruction manual to check errors.

4.3.5 **Communication confirmation**
Communication status is displayed.

- ![Unattached](Unattached): displayed when communication was failed.
- ![Importing](Importing): displayed when measured data was imported.
- ![Connect](Connect): displayed during data downloading.
4.3.6 Measurement status
When measured data is in the state of <Calib.>, <Other>, or <Error>, data field of the color changes corresponding to the status.

<Calib.>: Under calibration.
6.99 pH

<Other>: Under measurement or hold.
0.00 NTU

<Error>: Error data was measured.
55.00 °C

4.3.7 Data No.
Data No. is added in the order of acquisition of data. By selecting the number, the numbered data is displayed. You can go to forward and afterward data by pressing right/left keys.

4.3.8 Importing measured data/download data

- [Import measured data] [Stop importing]
  You can start or stop importing measured data. [Import measured data] is shown when measured data are not imported, and [Stop importing] are shown when measured data are imported. (See "5 Importing measured data.")

- [Download data]
  You can download data from the meter. (See "6 Download.")
4.3.9 **Graph**

Graph of imported data or downloaded data are displayed. The horizontal axis represents time, and the vertical axis represents the measured values for each parameter. 1 to 3 graphs can be displayed simultaneously. Parameters can be changed with the scrollbar on the right side.

- **[Graph settings]**
  You can set the graph style. (See "8.1.3 Graph settings.")

- **[X-Y graph]**
  You can create a X-Y graph. (See "8.2 X-Y graph.")

- **[Depth graph]**
  You can create a graph with depth as the axis. (See "8.3 Depth graph (U-52G, U-53, U-53G)" depth graph.)

### 4.3.10 Menu bar tree and shortcut button

<table>
<thead>
<tr>
<th>Action</th>
<th>Menu bar tree</th>
<th>Shortcut Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>To start importing measured data.</td>
<td>[Data] - [Import measured data]</td>
<td>Import measured data</td>
</tr>
<tr>
<td>To stop importing measured data.</td>
<td>[Data] - [Stop importing]</td>
<td>Stop importing</td>
</tr>
<tr>
<td>To download memory data.</td>
<td>[Data]-[Download data]</td>
<td>Download data</td>
</tr>
<tr>
<td>To change the number of graphs.</td>
<td>[Graph]-[Disp numbers] - [1 (or 2, 3)]</td>
<td></td>
</tr>
<tr>
<td>To set the graph.</td>
<td>[Graph] - [Settings]</td>
<td>Graph settings</td>
</tr>
<tr>
<td>To draw a depth graph.</td>
<td>[Graph] - [Depth graph]</td>
<td>Depth graph</td>
</tr>
<tr>
<td>To draw an X-Y graph.</td>
<td>[Graph] - [X-Y graph]</td>
<td>X-Y graph</td>
</tr>
</tbody>
</table>
5 Importing measured data

Measured data can be imported using "import measured data" function. Data is shown in graph and saved as csv format. See "8 Graph" For graphs, "7.1 Saving file" for saving data.

Note
• To import measured data, the meter's display unit and sensor probe must be connected and the measurement screen are displayed.
• 10000 data or less can be imported.

5.1 Setting of cycle (time interval) of data import

Time interval of measured data can be set.

1. Select [Import cycle] on the [Settings] menu.

2. Enter time interval between 1 and 9999 seconds, and click [OK].

Note
If 0 (zero) second was set, error windows are shown.
5.2 Importing measured data
1. Select [Import measured data] on the [Data] menu. You can also import with the [Import measured data] button in the lower portion of the main window.

2. The confirmation screen is displayed. Click [OK] to start importing.

5.3 Stop importing
1. To import data, click [Stop importing] on the [Data] menu. You can also stop importing with the [Stop importing] button.

2. The confirmation screen is displayed. Click [OK] to stop importing.
6 Download

Saved data in meter can be downloaded, and graph can be drawn. Data can be saved as csv format. See "8 Graph" For graphs, "7.1 Saving file" for saving data.

1. Select [Download data] on the [Data] menu. You can also download data with the [Download data] button.

2. A confirmation screen is displayed. Click [OK] to download.

If there is downloaded data, window below is displayed. To download data from the meter again, select [Yes].

3. The screen below is displayed during download. Wait until the download completes.

4. The <Data selection> window appears. Select the data to download and click [Download selected data]. Selected data are displayed in blue. In this example, No. 1 through 5 are selected.
7 Saving and opening files

7.1 Saving file
You can save imported data with the software as csv format.
2. Select the folder to save to with the <Save As> dialog, and enter a file name and save.

7.2 Open file
You can load data saved.
2. Select the file saved with the <Open> dialog.

Note
・You can only open csv files saved.
・Files opened by other programs cannot be opened with this software. The error message below is displayed.
### 7.3 Format of csv file

Files saved with this software are made up of the data below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Data</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No.</td>
<td>Data Number</td>
</tr>
<tr>
<td>2</td>
<td>SITE</td>
<td>SITE</td>
</tr>
</tbody>
</table>
| 3      | Date | Date and time the data was acquired  
When importing measured data: acquired from the computer's clock  
When downloading data: acquired from the meter's clock |
| 4      | Time | Date and time the data was acquired  
When importing measured data: acquired from the computer's clock  
When downloading data: acquired from the meter's clock |
| 5      | Latitude | Latitude acquired with GPS |
| 6      | Longitude | Longitude acquired with GPS |
| 7      | Probe error | Meter error  
For error details, see instruction manual of the meter. |
| 8      | Temperature | Value Temp value  
Unit Temp unit |
| 9      | Error | Temp error information |
| 10     | pH | Value pH value  
Unit pH unit |
| 11     | Error | pH error information |
| 12     | pHmV | Value pHmV value  
Unit pHmV unit |
| 13     | Error | pHmV error information |
| 14     | ORP | Value ORP value  
Unit ORP unit |
| 15     | Error | ORP error information |
| 16     | Conductivity | Value Cond value  
Unit Cond unit  
Error Cond error information |
| 17     | Turbidity | Value Turb value  
Unit Turb unit  
Error Turb error information |
| 18     | Dissolved Oxygen (mg/L) | Value DO (mg/L) value  
Unit DO (mg/L) unit  
Error DO (mg/L) error information |
| 19     | Dissolved Oxygen (%) | Value DO (%) value  
Unit DO (%) unit  
Error DO (%) error information |
| 20     | TDS | Value TDS value  
Unit TDS unit  
Error TDS error information |
| 21     | Salinity | Value Salinity value  
Unit Salinity unit  
Error Salinity error information |
| 22     | Specific gravity | Value SG value  
Unit SG unit |
| 23     | Depth | Value Depth value  
Unit Depth unit  
Error Depth error information |
| 24     | | |
| 25     | | |
| 26     | | |
| 27     | | |
| 28     | | |
| 29     | | |
| 30     | | |
| 31     | | |
| 32     | | |
| 33     | | |
| 34     | | |
| 35     | | |
| 36     | | |
| 37     | | |
| 38     | | |
| 39     | | |
| 40     | | |
| 41     | | |
| 42     | | |
| 43     | | |
| 44-54 | | Information to open the file with the software. |

**Note**
The title, csv file version, and amount of data is saved in the first line.
8 Graph
A graph of imported data or downloaded data is displayed in the main window. You can set the graph type and create an X-Y graph and depth graph.

8.1 Main window graph

8.1.1 Cursor
A red cursor indicates the position of measured data displayed on the left side. If you forward data No., the cursor moves.

8.1.2 Setting of the number of graphs displayed
You can select the number of graphs to display in the main window from 1 to 3 graphs. The selection can be made from [Disp numbers] on the [Graph] menu. The selection can also be made from the icons displayed in the upper-right of the graph. From the left, the icons represent 1, 2, and 3 graphs to display. Example shows 3 graphs.
8.1.3 Graph settings

Select [Settings] on the [Graph] menu to display the settings window. The settings window can also be displayed with the [Graph settings] button in the lower-right of the main window.

Note
The range cannot be directly entered when [Auto] is checked.
● **Parameter, unit**

The parameter and unit can be selected.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>°C</td>
</tr>
<tr>
<td>pH</td>
<td></td>
</tr>
<tr>
<td>pHmV</td>
<td></td>
</tr>
<tr>
<td>ORP</td>
<td></td>
</tr>
<tr>
<td>Conductivity</td>
<td></td>
</tr>
<tr>
<td>Turbidity</td>
<td></td>
</tr>
<tr>
<td>Dissolved Oxygen</td>
<td></td>
</tr>
<tr>
<td>DO%</td>
<td></td>
</tr>
<tr>
<td>TDS</td>
<td></td>
</tr>
<tr>
<td>Salinity</td>
<td></td>
</tr>
<tr>
<td>Specific gravity</td>
<td></td>
</tr>
<tr>
<td>Depth</td>
<td></td>
</tr>
</tbody>
</table>

● **Display range settings**

You can set the range of vertical axis of the graph.

If [Auto] is checked, the range is automatically determined from the data.

<table>
<thead>
<tr>
<th>Display range settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Auto] 20 - 30</td>
</tr>
</tbody>
</table>

If [Auto] is unchecked, the upper and lower limit values can be entered. In this example the lower limit is 20, the upper limit is 30.

<table>
<thead>
<tr>
<th>Display range settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] Auto 20 - 30</td>
</tr>
</tbody>
</table>

● **Time axis settings**

You can set the time axis of the graph.

1. Select the display format.
   - Calculated time: Displays the time axis as the elapsed time from the oldest data.
   - Direct time: Displays the time axis as the time the data was acquired.

<table>
<thead>
<tr>
<th>Time axis settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculated time</td>
</tr>
<tr>
<td>Direct time</td>
</tr>
</tbody>
</table>

2. Set the range of the horizontal axis of the graph.

If [Auto] is checked, the range is automatically determined from the data.

<table>
<thead>
<tr>
<th>[ ] Auto</th>
<th>Manual</th>
<th>[ ] In the previous data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 100s</td>
<td>100s</td>
<td>100s 100s</td>
</tr>
</tbody>
</table>
If [Manual] is checked, the upper and lower limit values can be entered. In this example the lower limit is 0, the upper limit is 10. The unit is seconds.

If [In the previous data] is checked, the graph is displayed with data going back from the newest until the entered time.

- **Cursor display**
  If [Cursor display] is checked, the cursor is displayed. When unchecked, the cursor is not displayed.

8.2 **X-Y graph**
You can set one parameter as the horizontal axis and check the correlation with other parameters.
8.2.1 Displaying the X-Y graph
Click [X-Y graph] on the lower-right of the main window to display the <X-Y graph> window. You can also display the X-Y graph with [X-Y graph] on the [Graph] menu.

8.2.2 X-Y graph explanation
You can select a single parameter for the X axis (horizontal axis).

For the Y axis (vertical axis), you can select parameters other than the parameter selected with the X axis. Temperature is selected for the X axis in this example. Graphs are displayed with each parameter color-coded.

The scale of the vertical axis is displayed as the scale of the parameter selected with [Y axis Scale]. For the other parameters, they are displayed in the scale set with [Graph settings], but the scale is not displayed.
8.2.3 Graph settings
You can set the graph by clicking [Graph settings] in the lower-left of the <X-Y graph> window.

See "8.1.3 Graph settings" for how to configure settings.
8.3 Depth graph (U-52G, U-53, U-53G)

With the depth graph, you can check the correlation between measured values and depth.

8.3.1 Displaying the depth graph

Click [Depth graph] on the lower-right of the main window to display the <Depth graph> window. You can also display the depth graph with [Depth graph] on the [Graph] menu.
8.3.2 Depth graph explanation

Select the parameter that you wish to check the correlation of to depth.

- Select units of parameter and depth.

The colored relationship with the selected parameter data is displayed.
The correlation between the selected parameter and the depth is displayed in color. The value displayed in the depth indicates the upper end of the range. In other words, depth 0 is 0 to 1 m, depth 29 is 29 to 30 m.

<table>
<thead>
<tr>
<th>Depth</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
</tr>
</tbody>
</table>
8.3.3 Add/delete data

You can add data to the graph by clicking [Add] on the lower-left of the Depth graph window and selecting a csv-formatted file saved with the software.

1. Click [Add].

2. Select a file and click [Open].

The data is added.

Clicking [Delete] to delete the data.
9 Troubleshooting

In case of troubles while using the software, first check the items listed below. If the problem is not resolved after performing these procedures, please contact to your local agency.

9.1 Checklist

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check here</th>
<th>Try this</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot install the software.</td>
<td>Free hard drive space is not sufficient.</td>
<td>Ensure enough free space.</td>
<td>2.4 (p. 3)</td>
</tr>
<tr>
<td>You cannot run the software.</td>
<td>The install was not finished correctly.</td>
<td>Reinstall the software.</td>
<td>3.1 (p 4)</td>
</tr>
<tr>
<td></td>
<td>Free hard drive space is not sufficient</td>
<td>Ensure enough free space.</td>
<td>2.4 (p. 3)</td>
</tr>
<tr>
<td></td>
<td>The communication cable is broken.</td>
<td>Replace the communication cable.</td>
<td></td>
</tr>
<tr>
<td>You cannot measure.</td>
<td>The connected port and set port are not the same.</td>
<td>Verify the connected port and set it correctly.</td>
<td>3.3 (p 9)</td>
</tr>
<tr>
<td></td>
<td>The meter is not turned ON.</td>
<td>Check the battery level, cycle the meter's power.</td>
<td>U-50 series Instruction manual</td>
</tr>
<tr>
<td></td>
<td>The display unit and sensor probe are not connected.</td>
<td>Connect the display unit and sensor probe.</td>
<td>U-50 series Instruction manual</td>
</tr>
<tr>
<td></td>
<td>The cable is broken.</td>
<td>Replace the cable.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Communication is blocked by noise.</td>
<td>Restart the computer and meter, and start up the software again.</td>
<td></td>
</tr>
<tr>
<td>You cannot download.</td>
<td>The connected port and set port are not the same.</td>
<td>Verify the connected port and set it correctly.</td>
<td>3.3 (p 9)</td>
</tr>
<tr>
<td></td>
<td>The meter is not turned ON.</td>
<td>Check the battery level, cycle the meter's power.</td>
<td>U-50 series Instruction manual</td>
</tr>
<tr>
<td></td>
<td>The cable is broken.</td>
<td>Replace the cable.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Communication is blocked by noise.</td>
<td>Restart the computer and meter, and start up the software again.</td>
<td></td>
</tr>
</tbody>
</table>

9.2 To contact your local agency

When you want to contact your local agency, check the items below in advance.

・ Date/time the problem occurred
・ Specify the problem
・ Model of the meter used
・ Computer specification (CPU, memory, free hard drive space, OS)
・ Software version
・ Other questions, requests
• Checking the version

You can check the version information by selecting [About] on the [Help] menu.